
Produktbeschreibung 

Das Mentype® DIPplex PCR Amplification Kit wurde als Multiplex-Anwendung zur 
Amplifikation von 30 DIPs (Deletion/Insertion Polymorphisms, auch als INDELs bekannt) 
entwickelt. In einem PCR-Ansatz werden 30 biallelische DIPs sowie Amelogenin (AM) 
zur Geschlechtsbestimmung simultan amplifiziert. Die Primer sind mit den 
Fluoreszenzfarbstoffen 6-FAM, BTG, BTY oder BTR markiert. 
 
Um die Darstellung des Genotyps zu erleichtern, empfehlen wir die Anwendung der 
kostenfreien DIPSorter Software. 
 
Für forensische Fragestellungen weisen die niedermolekularen DIP-Marker einen 
beträchtlichen Vorteil bei der Analyse degradierten Spurenmaterials auf, weshalb die 
maximale Amplikonlänge im Mentype® DIPplex auf etwa 150 bp beschränkt wurde. 
Ferner bilden DIPs keine Stutterpeaks, weshalb sie auch für die Mischspurenanalyse 
von Vorteil sind. Die 30 über 19 Autosomen verteilten DIP-Marker des 
Mentype® DIPplex wurden derart ausgewählt, dass sie eine physische Distanz von 
mindestens 10 Mbp zu kommerziell erhältlichen STR- oder SNP-Markern aufweisen 
(siehe Tab. 1). Somit verbessern DIPs - in Kombination mit anderen gängigen 
Standardmarkern - die Ausschlusswahrscheinlichkeit und bieten eine optimale 
Ergänzung für die Abstammungsbegutachtung. 
 
Die Nachweisgrenze für das Mentype® DIPplex Testkit liegt bei 100 pg genomischer 
DNA. Wir empfehlen den Einsatz von 0.2-0.5 ng DNA. 
 
 
Die Validierung und Evaluierung des Testkits wurden am GeneAmp® 9700 
Thermocycler, ABI PRISM® 310 Genetic Analyzer und ABI PRISM® 3100/3130 
Genetic Analyzer durchgeführt.  
 
Tabelle 1. Ausschlusswahrscheinlichkeiten von DIPs, STRs und SNPs 

 Loci CPE/Trio * CPI ** Population 
Mentype® DIPplex 30 DIPs 0.9980 2.83 x 10-13 German 
AmpFISTR Minifiler   8 STRs 0.99976 8.21 x 10-11 US Caucasian 
AmpFISTR SEfiler  11 STRs 0.999998 7.46 x 10-14 US Caucasian 
Powerplex 16 15 STRs 0.9999994 5.46 x 10-18 US Caucasian 
Sanchez et al. 2006 52 SNPs 0.9998 5.00 x 10-21 European 
*combined probability of paternity exclusion, **combined probability of identity 

Mentype® DIPplex PCR Amplification Kit 
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1. Beschreibung des Mentype® DIPplex 

Tabelle 2. Locus-spezifische Informationen für Mentype® DIPplex 
DIP Locus Chromosomale 

Kartierung 
GenBank® Accession / 
SNP ID 

Motiv (+DIP) Referenz  
Allel 

DIPplex_Blue     
AM X Xp22.1-22.3 M55418  X 
AM Y Yp11.2 M55419  Y 
HLD77 7q31.1 rs1611048 TAAG +DIP 
HLD45 2q31.1 rs2307959 CACG -DIP 
HLD131 7q36.2 rs1611001 TGGGCTTATT +DIP 
HLD70 6q16.1 rs2307652 AGCA -DIP 
HLD6 16q13 rs1610905 GCAGGACTGGGCACC -DIP 
HLD111 17p11.2 rs1305047 CACA -DIP 
HLD58 5q14.1 rs1610937 AGGA +DIP 
HLD56 4q25 rs2308292 TAAGT +DIP 
     
DIPplex_Green     
HLD118 20p11.1 rs16438 CCCCA -DIP 
HLD92 11q22.2 rs17174476 GTTT -DIP 
HLD93 12q22 rs2307570 ACTTT -DIP 
HLD99 14q23.1 rs2308163 TGAT -DIP 
HLD88 9q22.32 rs8190570 CCACAAAGA +DIP 
HLD101 15q26.1 rs2307433 GTAG -DIP 
HLD67 5q33.2 rs1305056 CTACTGAC -DIP 
     
DIPplex_Yellow     
HLD83 8p22 rs2308072 AAGG -DIP 
HLD114 17p13.3 rs2307581 TCCTATTCTACTCTGAAT -DIP 
HLD48 2q11.2 rs28369942 GACTT -DIP 
HLD124 22q12.3 rs6481 GTGGA -DIP 
HLD122 21q22.11 rs8178524 GAAGTCTGAGG -DIP 
HLD125 22q11.23 rs16388 ATTGCC -DIP 
HLD64 5q12.3 rs1610935 GACAAA +DIP 
HLD81 7q21.3 rs17879936 GTAAGCATTGT -DIP 
     
DIPplex_Red     
HLD136 22q13.1 rs16363 TGTTT -DIP 
HLD133 3p22.1 rs2067235 CAACCTGGATT -DIP 
HLD97 13q12.3 rs17238892 AGAGAAAGCTGAAG -DIP 
HLD40 1p32.3 rs2307956 GGGACAGGTGGCCACTAGGAGA +DIP 
HLD128 1q31.3 rs2307924 ATTAAATA -DIP 
HLD39 1p22.1 rs17878444 CCTAAACAAAAATGGGAT -DIP 
HLD84 8q24.12 rs3081400 CTTTC -DIP 
     
Abkürzungen: HLD = Human Locus DIP, -DIP = Deletions Polymorphismus, +DIP = Insertions Polymorphismus 
 
Tabelle 2 zeigt die DIP-Loci des Mentype® DIPplex mit ihren chromosomalen Kartierungen, 
den GenBank® / SNP ID Nummern und Motiven sowie Referenzallelen.  
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Inhalt 

Mentype® DIPplex PCR Amplification Kit (100 Reaktionen) 
Nuklease-freies Wasser / Nuclease-free water 3.0 mL 
Reaktionsgemisch A / Reaction mix A 500 μL 
Primergemisch / Primer mix 500 μL 
DNA Polymerase / DNA polymerase 60 μL 
Kontroll-DNA XY5 / Control DNA XY5 (2 ng/μL) 10 μL 
DNA Längenstandard 550 / DNA Size Standard 550 (BTO) 50 μL 
Allelleiter / Allelic ladder 25 μL 
 
 
Bestellinformation 
Mentype® DIPplex 25 Reaktionen Artikelnummer 45-31110-0025 
Mentype® DIPplex 100 Reaktionen Artikelnummer 45-31110-0100 
Mentype® DIPplex 400 Reaktionen Artikelnummer 45-31110-0400 

 
 
Lagerung 

Die Lagerung über einen längeren Zeitraum empfehlen wir bei –20°C. Wiederholtes 
Auftauen und Einfrieren sollte vermieden werden. Das Primergemisch und die 
Allelleiter sollten lichtgeschützt aufbewahrt werden. Die DNA-Proben und post-PCR 
Reagenzien (Allelleiter und DNA-Längenstandard) sollten getrennt von den PCR 
Reagenzien gelagert werden. Die Haltbarkeit des Testkits ist auf dem 
Verpackungsetikett angegeben. 
 
 
Zusätzliche Reagenzien 

Für die Amplifikation und Probenvorbereitung benötigen Sie neben den im Biotype® 
Testkit enthaltenen Bestandteilen folgende Reagenzien: 
Reagenz Lieferant Bestellnummer 
Hi-Di™ Formamide, 25 mL Applied Biosystems 4311320 
Matrix Standards BT5 
single-capillary instruments (5x25 μL) 

Biotype Diagnostic GmbH 00-10411-0025 

Matrix Standards BT5 
multi-capillary instruments (25 μL) Biotype Diagnostic GmbH 00-10421-0025 

Matrix Standards BT5 
multi-capillary instruments (50 μL) Biotype Diagnostic GmbH 00-10421-0050 
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Warnungen und Sicherheitshinweise 

Folgende potenziell gefährliche Substanz ist in diesem PCR Amplifikation Kit enthalten: 
Kitbestandteil Chemikalie Gefahr 
Primergemisch, Reaktionsgemisch 
und Allelleiter 

Natriumazid NaN3 giftig beim Verschlucken, entwickelt bei 
Berührung mit Säure giftige Gase 

Bitte beachten Sie das Sicherheitsdatenblatt. 
Für Biotype® Kitkomponenten sind die Sicherheitsdatenblätter bei uns erhältlich. Für 
Sicherheitsdatenblätter von Reagenzien, die nicht im Testkit enthalten sind, 
kontaktieren Sie bitte den jeweiligen Hersteller. 
 
 
Qualitätssicherung 

Der gesamte Inhalt des Testkits wird einer intensiven Qualitätssicherung durch die Biotype 
Diagnostic GmbH unterzogen. Die Qualität der Testkits wird kontinuierlich überprüft, um 
die uneingeschränkte Verwendbarkeit zu belegen. Bitte kontaktieren Sie uns in allen 
Fragen zur Qualitätssicherung. 
 
 
Warenzeichen und Patente 

Mentype® ist ein eingetragenes Warenzeichen der Biotype Diagnostic GmbH. 
ABI PRISM®, GeneScan®, Genotyper® GeneMapper™ und Applied Biosystems sind 
eingetragene Warenzeichen der Applied Biosystems Inc. 
6-FAM, POP-4 und Hi-Di sind Warenzeichen der Applied Biosystems Inc.  
GeneAmp® ist ein eingetragenes Warenzeichen von Roche Molecular Systems.  
Die PCR ist patentrechtlich geschützt. Patentinhaber sind die Firmen Roche Molecular 
Systems und F. Hoffmann-La Roche (Roche). 
GenBank® ist ein eingetragenes Warenzeichen vom National Institute of Health. 
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2. PCR Amplifikation 

2.1 Ansatz des Master Mixes 

Die folgende Tabelle zeigt die Volumina der eingesetzten Kitbestandteile bei 1 μL 
Probenvolumen (Template-DNA) in einem Reaktionsvolumen von 25 μL. 
Berücksichtigen Sie bei der Anzahl der PCR-Reaktionen die Positiv- und 
Negativkontrolle. Fügen Sie zu dieser Zahl ein oder zwei Reaktionen hinzu, um 
Pipettierfehler zu kompensieren. 
 
Komponente Volumen 
Nuklease-freies Wasser 13.4 μL 
Reaktionsgemisch A* 5.0 μL 
Primergemisch 5.0 μL 
Taq DNA Polymerase (hot start, 2.5 U/μL) 0.6 μL 
Volumen des Master Mixes 24.0 μL 

* enthält Mg2+, dNTPs, BSA 
 
Alle Reagenzien sollten vor dem Ansetzen des Master Mixes gemischt (Vortex) und kurz 
zentrifugiert werden (ca. 10 s).  
Die Menge der einzusetzenden DNA richtet sich nach ihrer Konzentration. Für 
Vergleichsproben ist meist 1 μL ausreichend. Für Spurenproben können 5 μL 
notwendig sein. Eine weitere Erhöhung der DNA-Menge über 5 μL hinaus ist nicht 
empfehlenswert, da enthaltene PCR-Inhibitoren u.U. nicht hinreichend ausverdünnt 
werden. Die Menge an Nuklease-freiem Wasser ist entsprechend zu korrigieren, 
sodass das Gesamtvolumen des PCR-Ansatzes immer 25 μL beträgt. 
 
Lagern Sie Ihre DNA-Proben in Nuklease-freiem Wasser oder in verdünntem TE Puffer 
(10 mM Tris HCl, pH 8.0 und 1 mM EDTA), z.B. 0.1x TE Puffer. 
 

Die Primergemische sind so eingestellt, dass bei 30 PCR-Zyklen mit 0.2 ng 
Kontroll-DNA XY5 in einem Reaktionsvolumen von 25 μL ausgewogene Peakhöhen 
erreicht werden. Wird mehr Template-DNA eingesetzt, so sind bei kleinen PCR-
Fragmenten sehr hohe Peaks und bei größeren PCR-Fragmenten verhältnismäßig 
niedrige Peaks zu erwarten. Reduzieren Sie die DNA-Menge, um diese 
Unausgewogenheit zu korrigieren. 
 

Positivkontrolle 

Für die Positivkontrolle verdünnen Sie die Kontroll-DNA XY5 auf 0.2 ng in dem 
entsprechenden Volumen. Pipettieren Sie die verdünnte Kontroll-DNA anstelle der 
Template-DNA in die Reaktionsgefäße mit dem vorgelegten PCR Master Mix. 
 

Negativkontrolle 

Als Negativkontrolle pipettieren Sie Nuklease-freies Wasser an Stelle der Template-
DNA in die Reaktionsgefäße mit dem vorgelegten PCR Master Mix.  
 

Template DNA 

In Abhängigkeit von der angewandten Quantifizierungsmethode kann der Messwert der 
DNA-Konzentration variieren, so dass die optimale DNA-Menge ggf. anzugleichen ist. 

Protokolle für die Amplifikation, Elektrophorese und Auswertung
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2.2 PCR Amplifikationsparameter 

Um die Taq DNA Polymerase zu aktivieren und die Bildung von unspezifischen 
Amplifikationsprodukten zu unterdrücken, sollte unbedingt ein „hot start“ durchgeführt 
werden. 
 
Die Zyklenzahl ist abhängig von der DNA-Menge. Für alle Proben werden 30 PCR-
Zyklen empfohlen. Für kritisches Spurenmaterial (< 100 pg DNA) wird eine Erhöhung 
der Zyklenzahl von 30 auf 32 Zyklen empfohlen, um optimale Signalintensitäten zu 
erreichen. 
 
Standard Methode 

empfohlen für alle DNA-Proben 
Temperatur Zeit 
94°C 4 min (hot start für Aktivierung der Multi Taq2 DNA Polymerase) 
94°C 30 s 
61°C 120 s 
72°C 75 s 

30 Zyklen 

68°C 60 min  
10°C ∞ bis zum Ende 

 
 
Optional 

empfohlen für Spurenproben mit geringen DNA-Mengen  
Temperatur Zeit 
94°C 4 min (hot start für Aktivierung der Multi Taq2 DNA Polymerase) 
94°C 30 s 
61°C 120 s 
72°C 75 s 

32 Zyklen 

68°C 60 min  
10°C ∞ bis zum Ende 

 
Aufgrund zu geringer DNA-Mengen kann es zu statistischen Ausfällen (Allelic Dropouts) 
und unausgewogenen Peakhöhen kommen. Außerdem steigt die Wahrscheinlichkeit 
von unspezifischen Amplifikationsprodukten. Mit zunehmender Zyklenzahl können 
zudem Kreuzkontaminationen durch minimale Mengen an Fremd-DNA auftreten. 
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3. Elektrophorese am ABI PRISM® 310 Genetic Analyzer 

Allgemeine Anweisungen zum Analysegerät, der Matrixerstellung und der Anwendung 
der GeneScan® und GeneMapper™ ID Software können der entsprechenden Anleitung 
ABI PRISM ® 310 Genetic Analyzer User’s Manual  entnommen werden. Im Folgenden 
wird die Elektrophorese mit der GeneScan® Software beschrieben. 
 

Für den kombinierten Einsatz der fünf Fluoreszenzfarbstoffe 6-FAM, BTG, BTY, BTR 
und BT0 (der Matrix Standard wird im Folgenden als BT5 bezeichnet) ist die Nutzung 
des virtuellen Filter Sets G5 vorgesehen.  
 
Material  
Kapillare 47 cm / 50 μm (grün) 
Polymer POP-4 for 310 Genetic Analyzer 
Puffer 10x Genetic Analyzer Buffer with EDTA 
 

3.1 Matrixerstellung 
Vor der Durchführung der Fragmentlängenanalyse mit dem Filter Set G5 muss 
zunächst eine Matrix mit PCR-Fragmenten der entsprechenden fünf 
Fluoreszenzfarbstoffe 6-FAM, BTG, BTY, BTR und BTO für das jeweilige Analysegerät 
erstellt werden.  
 
Farbe Matrix Standard  
Blau (B) 6-FAM  
Grün (G) BTG  
Gelb (Y) BTY  
Rot (R) BTR  
Orange (O) BTO  
 
Zur Erstellung von geeigneten Matrix Files werden fünf Elektrophoresen unter den 
gleichen Bedingungen ausgeführt wie sie auch für Proben und Allelleitern des Biotype® 
Testkits gelten. Für die fünf verschiedenen Fluoreszenzfarbstoffe 6-FAM, BTG, BTY, 
BTR und BTO muss jeweils ein eigener Elektrophoreselauf durchgeführt werden. 
 
Matrix Probe Komponente Volumen 

Hi-Di™ Formamide 12.0 μL 
Matrix Probe 1 

Matrix Standard 6-FAM 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix Probe 2 

Matrix Standard BTG 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix Probe 3 

Matrix Standard BTY 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix Probe 4 

Matrix Standard BTR 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix Probe 5 

Matrix Standard BTO 1.0 μL 
- 3 min denaturieren bei 95°C 
- abkühlen auf 4°C 
- gesamten Probenansatz zur Analyse auf Tray laden 
 

- Probenliste Sample Sheet erstellen und Proben bezeichnen
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Injektionsliste für die Matrixerstellung 
Parameter Einstellung 
Module File GS STR POP-4 (1 mL) G5 
Matrix File NONE 
Size Standard* NONE 
Injection [s] 5 
Injection [kV] 15.0 
Run [kV] 15.0 
Run [°C] 60 
Run Time [min] 24 

* Matrix Standards sind immer ohne DNA Längenstandard vorzubereiten  
 

Analyse der Matrix Proben 

- Starten der GeneScan® Software 
- File → New → Project (Ordner des entsprechenden Laufs öffnen) 
   → Add Sample Files 
- Markieren der Matrix Probe in der Spalte Sample File  
- Sample → Raw Data 
- Bewerten, ob eine stabile Basislinie vorhanden ist. Wie in der Abbildung gezeigt 

sollten mindestens fünf Peaks mit Peakhöhen von 1000-4000 (Y-Achse) in jeder 
Matrix Probe erkennbar sein (optimaler Bereich: 2000-4000) 

 

 
Abb. 1 Elektropherogramm der Rohdaten des Matrix Standards 6-FAM 
 
- Auswahl des Analysebereichs mit stabiler, ebener Basislinie 
- Falls notwendig, injizieren Sie die Matrix Probe noch einmal 
- Notieren von Anfangs- und Endpunkten (Data Points) des Auswahlbereiches, z.B.  
   Anfangswert 3200, Endwert 5500 
- Differenzwert berechnen, z.B. 5500-3200 = 2300 Data Points 

▼ 3200 Data Points (X) 
 

 5500▼ 
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Neue Matrix erstellen 

- File → New → Matrix 

 
Abb. 2 Matrix Proben auswählen 
 
- Matrix Proben für jede Farbe (B, G, Y, R, O) importieren 
- Jeweiligen Anfangspunkt bei Start At eintragen, z.B. 3200 
- Errechneten Differenzwert z.B. 2300 bei Points eintragen 
- Nach der Bestätigung mit OK wird die neue Matrix berechnet 
 

 
Abb. 3 Neue Matrix BT5 
 

- Speichern im Matrix Ordner: File → Save As, z.B. Matrix BT5 
 
Matrix prüfen 

Bitte überprüfen Sie die neue Matrix mit Ihren aktuellen Proben. 
- File → New → Project (Ordner des entsprechenden Laufs öffnen) 
   → Add Sample Files 
- Markieren Sie die aktuelle Probe in der Spalte Sample File  
- Sample → Install New Matrix  
   (Matrix Ordner öffnen und neue Matrix auswählen) 
- Proben neu analysieren 
 
Mit der neuen Matrix sollten keine Überstrahlungen (Pull-up Peaks) zwischen den 
verschiedenen Farbpaneln (B, G, Y, R, O) auftreten. 
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3.2 Probenvorbereitung 
Komponente Volumen 
Hi-Di™ Formamide 12.0 μL 
DNA Längenstandard 550 (BTO) 0.5 μL 
12 μL Gemisch (Formamid+ Längenstandard) für alle Proben vorlegen  
  1 μL PCR-Produkt (ggf. verdünnt) bzw. Allelleiter zugeben 
- 3 min denaturieren bei 95°C 
- abkühlen auf 4°C 
- gesamten Probenansatz zur Analyse auf Tray laden 
 
 
Signalintensitäten 

Möglichkeiten zur Erhöhung der Signalintensitäten: 
- Reduzierung der Anteile am DNA Längenstandard 550 (BTO) auf Peakhöhen von  
  ca. 500 relativen Fluoreszenzeinheiten (RFU) 
- Aufreinigung der PCR-Produkte vor der Analyse 
 
 

3.3 Einstellung der GeneScan® Software 

- Probenliste Sample Sheet erstellen und Proben bezeichnen 
 
Injektionsliste 
Parameter Einstellung 
Module File GS STR POP-4 (1 mL) G5 
Matrix File z.B. Matrix BT5 
Size Standard z.B. SST-BTO_60-200bp 
Injection [s]* 5 
Injection [kV] 15.0 
Run [kV] 15.0 
Run [°C] 60 
Run Time [min]** 20 

* Abweichend von der Standardeinstellung kann die Injektionszeit je nach Probe zwischen 1 und 10 s betragen. 
Handelt es sich um Vergleichsproben mit sehr hohen Peakhöhen, so kann zur Vermeidung von Überstrahlungen 
eine kürzere Injektionszeit gewählt werden. Bei Spurenproben können bis zu 10 s notwendig sein. 
 
** Abhängig von den Analysebedingungen ist die Run Time für Mentype® DIPplex angepasst worden, damit 
Fragmente bis zu einer Länge von 200 bp analysiert werden können. 
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3.4 Analyse Parameter 

Die empfohlenen Analyse Parameter sind: 
 
Analysis Range Start: 2000 

Stop: 6000 
Data Processing Baseline: Checked 

Multicomponent: Checked 
Smooth Options: Light 

Peak Detection Peak Amplitude Thresholds 
B:*    Y:* 
G:*    R:* 
O:* 
Min. Peak Half Width: 2 pts 
Polynominal Degree: 3 
Peak Window Size: 11 pts 

Size Call Range Min: 60 
Max: 550 

Size Calling Method Local Southern Method 
Split Peak Correction None 

* Der Grenzwert der Peakamplituden (threshold) ist die minimale Peakhöhe, welche die GeneScan® bzw. 
GeneMapper™ ID Software als einen Peak erkennt. Übliche Werte sind 50-200 RFU und sollten individuell vom 
Analyselabor festgelegt werden. Empfehlung: Die minimale Peakhöhe sollte mindestens 3x so hoch sein wie das 
Grundrauschen der Basislinie. 
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4. Elektrophorese am ABI PRISM® 3100-Avant/3100 Genetic Analyzer 

Allgemeine Anweisungen zum Analysegerät, zur Spektralkalibrierung und der 
Anwendung der ABI PRISM® 3100 Data Collection Software Version 1.01 oder 1.1 
sowie der GeneScan® Software können dem entsprechenden ABI PRISM ® ABI 3100-
Avant / 3100 Genetic Analyzer User’s Manual entnommen werden.  
 
Das 4-Kapillarsystem trägt die Bezeichnung ABI 3100-Avant, das 16-Kapillarsystem 
heißt ABI 3100. 
 
Für den kombinierten Einsatz der fünf Fluoreszenzfarbstoffe 6-FAM, BTG, BTY, BTR 
und BT0 (der Matrix Standard wird im Folgenden als BT5 bezeichnet) ist die Nutzung 
des virtuellen Filter Sets G5 vorgesehen. 
 
Material  
Kapillare 36 cm Capillary Array for 3100-Avant/3100 
Polymer POP-4 Polymer for 3100 
Puffer 10x Genetic Analyzer Buffer with EDTA 
 
 
4.1 Spektralkalibrierung / Matrixerstellung 
Vor der Durchführung der Fragmentlängenanalyse muss zunächst eine 
Spektralkalibrierung am ABI PRISM® 3100-Avant/3100 Genetic Analyzer durchgeführt 
werden. Auf diese Weise wird eine Matrix erstellt, die das Überlappen der 
farbspezifischen Fluoreszenzemissionsspektren korrigiert.  
 
Die Spektralkalibrierung gliedert sich in die folgenden Abschnitte: 
- Vorbereitung der Matrix Standards zur Spektralkalibrierung 
- Laden der Standards in die 96-Lochplatte (je Kapillare eine Probe) 
- Plattenzusammensetzung eingeben 
- Durchführung des Laufs zur Spektralkalibrierung und prüfen der Matrix 
 
Vorbereitung der Matrix Standards zur Spektralkalibrierung 

Beispiel für 4 Kapillaren/ABI 3100-Avant 
Komponente Volumen 
Hi-Di™ Formamide 60.0 μL 
Matrix Standard BT5 5.0 μL 
- 12 μL des Gemisches in 96-Lochplatte laden, z.B. Position A1-D1 
- 3 min denaturieren bei 95°C  
- abkühlen auf 4°C 
 
Beispiel für 16 Kapillaren/ABI 3100 
Komponente Volumen 
Hi-Di™ Formamide 204.0 μL 
Matrix Standard BT5 17.0 μL 
- 12 μL des Gemisches in 96-Lochplatte laden, z.B. Position A1-H1 und A2-H2 
- 3 min denaturieren bei 95°C 
- abkühlen auf 4°C 
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Durchführung der Spektralkalibrierung 

Um eine erfolgreiche Kalibrierung mit der Data Collection Software Version 1.0.1 oder 
1.1 durchzuführen, muss zunächst einmalig die Parameter Datei für DyeSetG5 
verändert werden.  
 

Spectral Parameter 

- Änderung der Parametereinstellungen unter dem Pfad:  
D:\AppliedBio\Support Files\Data Collection Support Files\ CalibrationData\Spectral 
Calibration\ ParamFiles 

- MtxStd{Genescan_SetG5} auswählen, um die PAR-Datei zu öffnen 
- Änderung des Condition bounds range auf [1.0;20.0]. Falls eine Kalibrierung nicht 

möglich ist, können im zweiten Schritt zusätzlich die Parameter Sensitivity auf 0.1 
und Quality auf 0.8 geändert werden 

- File Save As auswählen, um die Parameter Datei unter einem neuen Namen zu 
speichern, z.B. MtxStd{Genescan_SetG5_BT5}.par. 

 
Verwenden Sie für die Spektralkalibrierung mit Biotype® Matrix Standards BT5 immer 
die soeben erstellte Parameter Datei. 
 
Platteneditor zur Spektralkalibrierung (I) 
- Die vorbereitete 96-Lochplatte in den Autosampler setzen 
- Öffnen der ABI PRISM® 3100 Data Collection Software 
- Im Plate View der 3100 Data Collection Software auf New klicken, um den Plate 

Editor Dialog zu öffnen 
- Name der Platte eingeben 
- Spectral Calibration auswählen 
- 96-Well als Plattentyp auswählen und Finish wählen 
 
 
Platteneditor zur Spektralkalibrierung (II) 
Parameter Einstellung 
Sample Name Benennung der Matrixproben 
Dye Set  G5 
Spectral Run Module Default (z.B. Spect36_POP4) 
Spectral Parameters MtxStd{GeneScan_SetG5_BT5}.par (Parameter zuvor erstellt) 
 
- In die oberste Zelle der Tabelle klicken, um die gesamte Spalte auszuwählen, über  

Edit → Fill Down die Informationen den ausgewählten Matrixproben zufügen und 
mit OK bestätigen 

- Verknüpfen der 96-Lochplatte auf dem Autosampler mit der soeben erstellten 
Plattenbezeichnung und den Lauf starten 

- Nach dem Lauf in der Spectral Calibration Result prüfen, ob alle Kapillaren 
erfolgreich kalibriert wurden (Kennzeichnung A). Bei Kennzeichnung X sind die 
Anweisungen im ABI PRISM ® Genetic Analyzer User’s Manual zu beachten 

- Auf OK klicken, um den Lauf zu bestätigen  
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Matrix prüfen 

- Wähle Tools → Display Spectral Calibration → Dye Set → G5, um die 
Spektralkalibrierung jeder Kapillare zu kontrollieren  

- Jede Kapillare sollte einen Qualitätswert (Q Value) von mindestens 0.95 sowie eine 
Konditionszahl (C Value) zwischen 1 und 20 haben, beide Werte müssen im zuvor 
festgelegten Bereich liegen 

- Bewerten, ob eine stabile Basislinie vorhanden ist. Es müssen fünf Peaks mit 
Peakhöhen von 1000-5000 (Y-Achse) in jeder Kapillare erkennbar sein (optimaler 
Bereich: 2000-4000) 

- Bitte überprüfen Sie die neue Matrix mit Ihren aktuellen Proben. Mit der neuen Matrix 
sollten keine Überstrahlungen (Pull-up Peaks) zwischen den verschiedenen 
Farbpanels (B, G, Y, R, O) auftreten 

- Sollte die Kalibrierung nicht erfolgreich sein, ändern Sie bitte die Werte für 
Sensitivity und Quality wie zuvor in der Parameter Datei beschrieben 

- Haben alle Kapillaren die Kalibrierung erfolgreich durchlaufen, muss die aktuelle 
Kalibrierungsdatei für das Dye Set G5 unter Tools → Set Active Spectral 
Calibration manuell aktiv gesetzt werden. Eine Umbenennung ist über Set Matrix 
Name möglich (z.B. BT5_Datum der Kalibrierung) 

 

4.2 Probenvorbereitung 
Komponente Volumen 
Hi-Di™ Formamide 12.0 μL 
DNA Längenstandard 550 (BTO) 0.5 μL 
12 μL Gemisch (Formamid+ Längenstandard) für alle Proben vorlegen 
  1 μL PCR-Produkt (ggf. verdünnt) oder Allelleiter zugeben 
- 3 min denaturieren bei 95°C  
- abkühlen auf 4°C 
- gesamten Probenansatz zur Analyse auf Tray laden 
 
Da die Injektion gleichzeitig an allen Kapillaren stattfindet, müssen am 
Mehrkapillargerät immer 4 oder 16 Proben auf der Platte pipettiert werden. Falls 
weniger Proben zu messen sind, müssen die entsprechenden Positionen mit 12 μL   
Hi-Di™ Formamide aufgefüllt werden. 
 

Um eine sichere Allelzuordnung am Mehrkapillargerät zu gewährleisten, sollten 
unabhängig von der Probenanzahl mehrere Allelleitern mitlaufen. 
 

Die Raumtemperatur kann das Laufverhalten der PCR-Produkte an Mehrkapillargeräten 
stark beeinflussen und bei zu geringer Temperatur zum Auftreten von Doppelpeaks 
(Split Peaks) führen. Unter Umständen nimmt die Temperatur auch Einfluss auf die 
Laufgeschwindigkeit der Fragmente. Bitte achten Sie darauf, dass die vom 
Gerätehersteller empfohlene Arbeitstemperatur eingehalten wird. 
 
Signalintensitäten 

Möglichkeiten zur Erhöhung der Signalintensitäten: 
- Reduzierung des Anteiles am DNA Längenstandard 550 (BTO) auf Peakhöhen von  
  ca. 500 relativen Fluoreszenzeinheiten (RFU) 
- Aufreinigung der PCR Produkte vor der Analyse 
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4.3 Einstellung der GeneScan® Software 

Vor dem ersten Lauf muss das voreingestellte Run Modul im Dye Set G5 einmalig editiert 
werden: 
- Zum Öffnen der Dialog Box auf Module Editor klicken 
- Aus der Tabelle GeneScan das entsprechenden Run Module als Vorlage auswählen 
- Ändern der Spannung (Injection Voltage) auf 3 kV und der Injektionszeit (Injection 

Time) auf 10 s 
 

Run Modul 3kV_10s_260bp 
Parameter Einstellung 
Run Temperature [°C] Default 
Cap Fill Volume Default 
Maximum Current [A] Default 
Current Tolerance [A] Default 
Run Current [A] Default 
Voltage Tolerance [kV] Default 
Pre Run Voltage [kV] Default 
Pre Run Time [s] Default 
Injection Voltage [kV] 3.0 
Injection Time [s]* 10 
Run Voltage [kV] Default 
Number of Steps Default 
Voltage Step Interval Default 
Data Delay Time [s] Default 
Run Time [min]** 15 

* Abweichend von der Standardeinstellung kann die Injektionszeit je nach Probe zwischen 1 und 20 s betragen. 
Handelt es sich um Vergleichsproben mit sehr hohen Peakhöhen, kann zur Vermeidung von Überstrahlungen 
eine kürzere Injektionszeit gewählt werden. Bei Spurenproben können bis zu 20 s notwendig sein. 
 

** Abhängig von den Analysebedingungen ist die Run Time für Mentype® DIPplex angepasst worden, damit 
Fragmente bis zu einer Länge von 200 bp analysiert werden können. 
 

- Auf Save As klicken, den Namen des neuen Moduls eingeben (z.B. 
3kV_10s_260bp) und mit OK bestätigen  

- Zum Verlassen des Run Module Editors auf Close klicken 
 
 
Run starten 

- Die vorbereitete 96-Lochplatte in den Autosampler setzen 
- Öffnen der ABI PRISM® 3100 Data Collection Software 
- Im Plate View der 3100 Data Collection Software auf New klicken, um den Plate 

Editor Dialog zu öffnen 
- GeneScan auswählen 
- 96-Well als Plattentyp auswählen und Finish anklicken 
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Platteneditor 
Parameter Einstellung 
Sample Name Type name for the samples 
Dyes  O 
Colour Info Ladder or Sample 
Project Name z.B. 3100_Project1 
Dye Set  G5 
Run Module* 3kV_10s_260bp 
Analysis Module 1 DefaultAnalysis.gsp 

* Parameter siehe oben 
 
- Vervollständigen der Tabelle im Plate Editor und OK wählen 
- In die oberste Zelle der Tabelle klicken, um die gesamte Spalte auszuwählen und 

Edit → Fill Down wählen, um die Informationen der ausgewählten Probe zu-
zuordnen 

- Verknüpfen der 96-Lochplatte auf dem Autosampler mit der soeben erstellten 
Plattenbezeichnung und den Lauf starten 

- Nach dem Lauf sind die Daten als Color Data in Array View der 3100 Data 
Collection Software oder als Analyzed Sample Files unter dem Pfad 
D:/AppliedBio/3100/DataExtractor/ExtractRuns vorzufinden 

 
 

4.4 Analyse Parameter 

Die empfohlenen Analyse Parameter sind: 
 
Analysis Range Start: 2200 

Stop: 6000 
Data Processing Baseline: Checked 

Multicomponent: Checked 
Smooth Options: Light 

Peak Detection Peak Amplitude Thresholds 
B:*    Y:* 
G:*    R:* 
O:* 
Min. Peak Half Width: 2 pts 
Polynominal Degree: 3 
Peak Window Size: 11 pts 

Size Call Range Min: 60 
Max: 550 

Size Calling Method Local Southern Method 
Split Peak Correction None 

* Der Grenzwert der Peakamplituden (threshold) ist die minimale Peakhöhe, welche die GeneScan® bzw. 
GeneMapper™ ID Software als einen Peak erkennt. Übliche Werte sind 50-200 RFU und sollten individuell vom 
Analyselabor festgelegt werden. Empfehlung: Die minimale Peakhöhe sollte mindestens 3x so hoch sein wie das 
umgebende Grundrauschen der Basislinie. 
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5. Elektrophorese am ABI PRISM® 3130/3130xl Genetic Analyzer 

Allgemeine Anweisungen zum Analysegerät, zur Spektralkalibrierung und der 
Anwendung der ABI PRISM® Data Collection Software Version 3.0 und der 
GeneMapper™ ID Software können der entsprechenden Anleitung ABI PRISM ® 
3130/3130xl Genetic Analyzers Getting Started Guide entnommen werden.  
 
Das 4-Kapillarsystem trägt die Bezeichnung ABI 3130, das 16-Kapillarsystem heißt 
ABI 3130xl. 
 
Für den kombinierten Einsatz der fünf Fluoreszenzfarbstoffe 6-FAM, BTG, BTY, BTR 
und BT0 (der Matrix Standard wird im Folgenden als BT5 bezeichnet) ist die Nutzung 
des virtuellen Filter Sets Any5Dye vorgesehen.  
 
Material  
Kapillare 36 cm Capillary Array for 3130/3130xl 
Polymer POP-4 Polymer for 3130 
Puffer 10x Genetic Analyzer Buffer with EDTA 
 
 

5.1 Spektralkalibrierung / Matrixerstellung 

Vor der Durchführung der Fragmentlängenanalyse muss zunächst eine 
Spektralkalibrierung mit PCR-Fragmenten der entsprechenden fünf 
Fluoreszenzfarbstoffe 6-FAM, BTG, BTY, BTR und BTO für das jeweilige Analysegerät 
durchgeführt werden. Auf diese Weise wird eine Matrix erstellt, die das Überlappen der 
farbspezifischen Fluoreszenzemissionsspektren korrigiert.  
 
Die Spektralkalibrierung gliedert sich in die folgenden Abschnitte: 
- Vorbereitung der Matrix Standards zur Spektralkalibrierung 
- Laden der Standards in die 96-Lochplatte (je Kapillare eine Probe) 
- Erstellung des Instrument Protocol zur Spektralkalibrierung (Protocol Manager) 
- Plattenzusammensetzung im Platteneditor festlegen (Plate Manager) 
- Durchführung des Laufs zur Spektralkalibrierung und prüfen der Matrix 
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Vorbereitung der Matrix Standards zur Spektralkalibrierung 

Beispiel für 4 Kapillaren/ABI 3130 
Komponente Volumen 
Hi-Di™ Formamide 60.0 μL 
Matrix Standard BT5 5.0 μL 
- 12 μL des Gemisches in 96-Lochplatte laden, z.B. Position A1-D1  
- 3 min denaturieren bei 95°C 
- abkühlen auf 4°C 
 
 
Beispiel für 16 Kapillaren/ABI 3130xl 
Komponente Volumen 
Hi-Di™ Formamide 204.0 μL 
Matrix Standard BT5 17.0 μL 
- 12 μL des Gemisches in 96-Lochplatte laden, z.B. Position A1-H1 und A2-H2 
- 3 min denaturieren bei 95°C  
- abkühlen auf 4°C 
 
 
Durchführung der Spektralkalibrierung 
- Die vorbereitete 96-Lochplatte in den Autosampler setzen 
- Im Protocol Manager der Data Collection Software im Fenster Instrument 

Protocol auf New klicken, um den Protocol Editor zu öffnen 
 
 
Instrument Protocol zur Spektralkalibrierung 
Parameter Einstellung 
Name User (z.B. Spectral36_POP4_BT5) 
Type SPECTRAL 
Dye Set Any5Dye 
Polymer* User (z.B. POP4) 
Array Length* User (z.B. 36cm) 
Chemistry Matrix Standard 
Run Module* Default (z.B. Spect36_POP4_1) 

* Richtet sich nach dem verwendeten Polymertyp und der Kapillarlänge 
 
- OK wählen, um den Protocol Editor zu verlassen 
- Im Plate Manager der Data Collection Software auf New klicken, um New Plate 

Dialog zu öffnen 
 
Platteneditor zur Spektralkalibrierung (I) 
New Plate Dialog Einstellung 
Name z.B. Spectral_BT5_Datum 
Application Spectral Calibration 
Plate Type 96-Well 
Owner Name / Operator Name … 
 
- OK wählen. Auf diese Weise öffnet sich automatisch eine neue Tabelle im 

Platteneditor 
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Platteneditor zur Spektralkalibrierung (II) 
Parameter Einstellung 
Sample Name Benennung der Matrixproben 
Priority  z.B. 100  
Instrument Protocol 1 Spectral36_POP4_BT5 (Einstellung zuvor beschrieben) 
 

- In die oberste Zelle der Tabelle klicken, um die gesamte Spalte auszuwählen, über  
Edit → Fill Down diese Information den ausgewählten Matrixproben zufügen und 
mit OK bestätigen 

- In Run Schedule → Find All anklicken, dann link wählen, um die 96-Lochplatte 
auf dem Autosampler mit der soeben erstellten Plattenbezeichnung zu verknüpfen 
(Position A oder B). Anschließend den Lauf starten 

 

 
Abb. 4 Elektropherogramm der Spektralkalibrierung mit Matrix Standards BT5 am ABI 3130 
 

Matrix prüfen 

- Jede Kapillare sollte einen Qualitätswert (Q Value) von mindestens 0.95 sowie eine 
Konditionszahl (Condition number range) zwischen 1 und 20 haben. 

- Bewerten, ob eine stabile Basislinie vorhanden ist. Es müssen fünf Peaks mit 
Peakhöhen von 1000-5000 (Y-Achse) in jeder Kapillare erkennbar sein (optimaler 
Bereich: 2000-4000), siehe Abbildung 

- Bitte überprüfen Sie die neue Matrix mit Ihren aktuellen Proben. Mit der neuen Matrix 
sollten keine Überstrahlungen (Pull-up Peaks) zwischen den verschiedenen 
Farbpanels (B, G, Y, R, O) auftreten. 

- War die Kalibrierung nicht erfolgreich, ist eine Wiederholung der Spektralkalibrierung 
mit optimierten Werten notwendig 

       O,          R,       Y,        G,      B 
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- Haben alle Kapillaren die Kalibrierung erfolgreich durchlaufen, wird die Kalibrierungs-
datei für Any5Dyes im Spectral Viewer automatisch aktiv gesetzt. Eine 
Umbenennung ist über Rename möglich (z.B. BT5_Datum der Kalibrierung) 

 
 

5.2 Probenvorbereitung 
Komponente Volumen 
Hi-Di™ Formamide 12.0 μL 
DNA Längenstandard 550 (BTO) 0.5 μL 
12 μL Gemisch (Formamid+ Längenstandard) für alle Proben vorlegen 
  1 μL PCR-Produkt (ggf. verdünnt) oder Allelleiter zugeben 
- 3 min denaturieren bei 95°C 
- abkühlen auf 4°C 
- gesamten Probenansatz zur Analyse auf Tray laden 
 
Da die Injektion gleichzeitig an allen Kapillaren stattfindet, müssen am 
Mehrkapillargerät immer 4 oder 16 Proben auf der Platte pipettiert werden. Falls 
weniger Proben zu messen sind, müssen die entsprechenden Positionen mit 12 μL   
Hi-Di™ Formamide aufgefüllt werden. 
 
Um eine sichere Allelzuordnung am Mehrkapillargerät zu gewährleisten, sollten 
unabhängig von der Probenanzahl mehrere Allelleitern mitlaufen. 
 
Die Raumtemperatur kann das Laufverhalten der PCR-Produkte an Mehrkapillargeräten 
stark beeinflussen und bei zu geringer Temperatur zum Auftreten von Doppelpeaks 
(Split Peaks) führen. Unter Umständen nimmt die Temperatur auch Einfluss auf die 
Laufgeschwindigkeit der Fragmente. Bitte achten Sie darauf, dass die vom 
Gerätehersteller empfohlene Arbeitstemperatur eingehalten wird. 
 
 
Signalintensitäten 

Möglichkeiten zur Erhöhung der Signalintensitäten: 
- Reduzierung der Anteile am DNA Längenstandard 550 (BTO) auf Peakhöhen von  
  ca. 500 relativen Fluoreszenzeinheiten (RFU) 
- Aufreinigung der PCR-Produkte vor der Analyse 
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5.3 Einstellung der GeneMapper™ ID Software 

Vor dem ersten Probenlauf muss das Run Modul wie folgt editiert werden: 
- Im Module Manager der Data Collection Software auf New klicken, um den Run 

Module Editor zu öffnen 
 
Run Modul 3kV_10s_260bp 
Parameter Einstellung 
Oven Temperature [°C] Default 
Poly Fill Volume Default 
Current Stability [μA] Default 
PreRun Voltage [kV] Default 
PreRun Time [s] Default 
Injection Voltage [kV] 3.0 
Injection Time [s]* 10 
Voltage Number of Steps Default 
Voltage Step Interval Default 
Data Delay Time [s] Default 
Run Voltage [kV] Default 
Run Time [s]** 900 

* Abweichend von der Standardeinstellung kann die Injektionszeit je nach Probe zwischen 1 und 20 s betragen. 
Handelt es sich um Vergleichsproben mit sehr hohen Peakhöhen, kann zur Vermeidung von Überstrahlungen 
eine kürzere Injektionszeit gewählt werden. Bei Spurenproben können bis zu 20 s notwendig sein. 
 

** Abhängig von den Analysebedingungen ist die Run Time für Mentype® DIPplex angepasst worden, damit 
Fragmente bis zu einer Länge von 200 bp analysiert werden können. 
 
 

- Auf Save As klicken, den Namen des neuen Moduls eingeben (z.B. 3kV_10s_260bp) 
und mit OK bestätigen 

- Zum Verlassen des Run Module Editors auf Close klicken 
 
 
Run starten 

- Die vorbereitete 96-Lochplatte in den Autosampler setzen 
- Im Protocol Manager der Data Collection Software im Fenster Instrument 

Protocol auf New klicken, um den Protocol Editor zu öffnen 
 
Instrument Protocol 
Protocol Editor Einstellung 
Name Run36_POP4_BT5_15min 
Type REGULAR 
Run Module* 3kV_10s_260bp 
Dye Set Any5Dye 

* Parameter siehe oben 
 
- OK wählen, um den Protokolleditor zu verlassen 
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Vor jedem Probenlauf muss die zu messende Platte wie folgt angelegt werden: 
- Im Plate Manager der Data Collection Software auf New klicken, um New Plate 

Dialog zu öffnen 
 
GeneMapper™ Platteneditor (I) 
New Plate Dialog Einstellung 
Name z.B. Plate_BT5_Datum 
Application wählen Sie GeneMapper Application 
Plate Type 96-Well 
Owner Name / Operator Name … 
 
- OK wählen. Auf diese Weise öffnet sich automatisch eine neue Tabelle im 

Platteneditor 
 
GeneMapper™ Platteneditor (II) 
Parameter Einstellung 
Sample Name Benennung der Probe 
Priority  z.B. 100 (Voreinstellung) 
Sample Type Probe oder Allelleiter 
Size Standard z.B. SST-BTO_60-260bp 
Panel z.B. DIPplex_Panels_v0 
Analysis Method z.B. DIPplex_HID_3130_200rfu 
Snp Set - 
User-defined 1-3 - 
Results Group 1 (Results Group auswählen) 
Instrument Protocol 1 Run36_POP4_BT5_15min (Einstellung zuvor beschreiben) 
 
- In die obersten Zellen der Tabelle klicken, um die gesamte Spalte auszuwählen, über 

Edit → Fill Down diese Informationen den ausgewählten Proben zufügen und mit 
OK bestätigen  

- In Run Schedule → Find All wählen, dann auf link klicken, um die 96-Lochplatte 
auf dem Autosampler mit der soeben erstellten Plattenbezeichnung zu verknüpfen 
(Position A oder B). Anschließend den Lauf starten 

- Die Qualität der Rohdaten kann während des Laufs für jede einzelne Kapillare im 
Capillaries Viewer oder Cap/Array Viewer beobachten werden. Mögliche 
Fehlermeldungen (Error Status) erscheinen in Event Log  

- Die Daten des Probenlaufs werden unter Run History oder Cap/Array Viewer der 
Data Collection Software im Überblick dargestellt. Die Laufdaten der Proben werden 
im Run Folder der zuvor gewählten Results Group abgelegt 
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5.4 Analyse Parameter / Analysis Method DIPplex 

Die empfohlenen Einstellungen im Tabellenblatt Peak Detector sind:  
Peak Detection Algorithm Advanced 
Ranges Analysis: Partial Range 

Start Pt: 2200; Stop Pt: 6000 
Sizing: All Sizes 

Smoothing and Baselining Smoothing: Light  
Baseline Window: 51 pts 

Size Calling Method Local Southern Method 
Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 
G:*    R:* 
O:* 
Min. Peak Half Width: 2 pts 
Polynominal Degree: 3 
Peak Window Size: 11 pts 
Slope Thresholds: 0.0 

 
Die empfohlenen Einstellungen im Tabellenblatt Allele sind: 
Amelogenin Cutoff** 0.1 
 

Die empfohlenen Einstellungen im Tabellenblatt Peak Quality sind: 
Heterozygote balance Min peak height ratio: 0.1 
Allele number Max expected alleles: 20 

 

* Der Grenzwert der Peakamplituden (threshold) ist die minimale Peakhöhe, welche die GeneMapper™ ID 
Software als einen Peak erkennt. Übliche Werte sind 50-200 RFU und sollten individuell vom Analyselabor 
festgelegt werden. Empfehlung: Die minimale Peakhöhe sollte mindestens 3x so hoch sein wie das umgebende 
Grundrauschen der Basislinie. 

** Alle DIPs werden von der GeneMapper™ ID Software wie Amelogenin behandelt. 
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6. Auswertung 

Allgemeine Anweisungen zur automatischen Auswertung können der entsprechenden 
Anleitung GeneScan ® oder GeneMapper™ ID Software User’s Manual entnommen 
werden. 
Die Ermittlung der genauen Fragmentlängen der amplifizierten Produkte ist abhängig 
vom Gerätetyp, von den Elektrophoresebedingungen sowie von dem verwendeten DNA 
Längenstandard. Aufgrund der Komplexität einiger DIP-Loci sollten möglichst viele, 
gleichmäßig verteilte Referenzpunkte zur Längenbestimmung herangezogen werden. 
Hierzu verwenden Sie den DNA Längenstandard 550 (BTO) mit den Fragmentlängen 
60, 80, 90, 100, 120, 140, 160, 180, 200, 220, 240, 250, 260, 280, 300, 320, 
340, 360, 380, 400, 425, 450, 475, 500, 525 und 550 bp. 
 

Abb. 5 Elektropherogramm des DNA Längenstandard 550 (BTO), Fragmentlängen in bp 
 
Mentype® DIPplex: Die Grundvorlage des DNA-Längenstandards 550 (BTO) für die 
GeneMapper™ ID Software wurde für 60-260 bp erstellt. Eine eigene neu erstellte 
Vorlage kann unter dem Namen SST-BTO_60-260bp gespeichert und für weitere 
Analysen verwendet werden. 
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6.1 Biotype® Auswertevorlagen 

Die Allelzuordnungen der aufgetrennten PCR-Produkte (Genotyping) kann mit Hilfe 
geeigneter Auswertungssoftware erfolgen, z.B. mit GeneMapper™ ID oder Genotyper® 

Software in Kombination mit Mentype® DIPplex Auswertevorlagen der Biotype. 
Biotype® Auswertevorlagen (Template Files) finden Sie auf unserer Homepage 
(www.biotype.de) zum Download. Auf Anfrage senden wir Ihnen gerne eine CD-ROM 
zu. 
 
Um die Darstellung des Genotyps zu erleichtern, stellen wir die kostenfreie Software 
DIPSorter zur Verfügung. Für die Nutzung der DIPSorter Software achten Sie bitte auf 
die Verwendung der empfohlenen Table Settings für die Darstellung und den Export 
der Genotyp Tabellen aus der GeneMapper™ ID (Table for 20 Alleles) oder Genotyper® 
Software (Vertical Table for 20 Alleles). 
 
Sample Name Marker Dye Allele 1 Allele 2 … Allele 20 … 
Export Table from GeneMapper™ ID software 
 
File Name Sample Info Category Peak 1 Peak 2 … Peak 20 
Export Table from Genotyper® software 
 
 
Empfohlene Biotype® Vorlagen für GeneMapper™ ID Software sind: 
Panels DIPplex_Panels_v0 oder höhere Version 
BinSets DIPplex_Bins_v0 oder höhere Version 
Size Standard SST-BTO_60-260bp  
Analysis Method DIPplex_HID_310_50rfu  
 DIPplex_HID_310_200rfu  
 DIPplex_HID_3130_50rfu  
 DIPplex_HID_3130_200rfu  
Plot Settings Plots_5dyes  
Table Settings Table for 20 Alleles   
 
Die empfohlenen Biotype® Vorlagen für die Genotyper® Software sind: 
DIPplex_v0 oder höhere Version 
 
 
Allgemeine Vorgehensweise bei der Auswertung 

1. Prüfen des Längenstandards (Size Standard) 
2. Prüfen der Allelleiter (Allelic Ladder) 
3. Prüfen der Positivkontrolle 
4. Prüfen der Negativkontrolle 
5. Probendaten auswerten 



 

Mentype® DIPplex Dezember 2009 

27 

6.2 Kontrollen 

Die im Testkit enthaltene Kontroll-DNA XY5 sowie kommerziell erhältliche DNAs 
repräsentieren folgende Allele: 
 
Tabelle 3. Allelzuordnungen mit Mentype® DIPplex 

Locus Kontroll-
DNA XY5 

ATCC 
K-562 

CCR 
9947A 

CCR 
9948 

CCR 
3657 

AM X/Y X X X/Y X/Y 
HLD77 + -/+ - + + 
HLD45 - - -/+ + -/+ 
HLD131 -/+ -/+ - -/+ + 
HLD70 - -/+ + -/+ - 
HLD6 -/+ + + -/+ -/+ 
HLD111 - + -/+ -/+ -/+ 
HLD58 -/+ - + + + 
HLD56 - - -/+ - -/+ 
      
HLD118 -/+ - - - -/+ 
HLD92 + + -/+ + - 
HLD93 -/+ + - - -/+ 
HLD99 -/+ + -/+ + -/+ 
HLD88 -/+ - - -/+ + 
HLD101 -/+ -/+ -/+ -/+ -/+ 
HLD67 + -/+ + + + 
      
HLD83 -/+ - -/+ - - 
HLD114 - - - + -/+ 
HLD48 -/+ + + -/+ + 
HLD124 -/+ - -/+ + + 
HLD122 - - -/+ - -/+ 
HLD125 - - -/+ + - 
HLD64 -/+ - + -/+ -/+ 
HLD81 -/+ -/+ - -/+ + 
      
HLD136 -/+ + -/+ + -/+ 
HLD133 -/+ - + + -/+ 
HLD97 -/+ - -/+ -/+ + 
HLD40 -/+ + - -/+ + 
HLD128 - -/+ -/+ - -/+ 
HLD39 -/+ -/+ - + - 
HLD84 - + - -/+ - 
      
 
Die Referenz-DNA K-562 ist bei ATCC zu beziehen (http://www.atcc.org/Products/ 
PurifiedDNA.cfm#celllines). Die Referenz-DNA 9947A, 9948 und 3657 sind bei Coriell 
Cell Repositories erhältlich (CCR; http://locus.umdnj.edu/nigms). Damit wird den 
Anforderungen von Szibor et al. (2003) entsprochen. 
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6.3 Fragmentlängen und Allele 

Die in Tabelle 4 bis Tabelle 5 angegebenen Werte für Fragmentlängen einzelner 
Allele beziehen sich auf den DNA Längenstandard 550 (BTO) und die Messung am ABI 
PRISM® 310/3130 Genetic Analyzer mit POP-4 Polymer. Unterschiedliche 
Analysegeräte, DNA Längenstandards oder Polymere können zu anderen 
Fragmentlängen führen. Es wird empfohlen, bei jedem Lauf einen visuellen Abgleich 
mit der entsprechenden Allelleiter vorzunehmen. 
 
 
Skalierung 

Horizontal: 70-205 bp 
Vertikal:  nach Signalintensität der Proben
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Abbildung 6 
 
 
 
 
 
       

Abb. 6 Elektropherogramm des Mentype® DIPplex unter Verwendung von 200 pg Kontroll-DNA XY5. Die Analyse 
erfolgte am ABI PRISM® 3130 Genetic Analyzer mit dem DNA Längenstandard 550 (BTO). Die Allelzuordnung wurde 
mit der GeneMapper™ ID Software und dem Mentype® DIPplex Template File durchgeführt. 

DNA Längenstandard 550 (BTO) 
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Abbildung 7 
 

 

 

 

Abb. 7 Elektropherogramm der Allelleiter Mentype® DIPplex. Die Analyse erfolgte am ABI PRISM® 3130 Genetic 
Analyzer mit dem DNA Längenstandard 550 (BTO). Die Allelzuordnung wurde mit der GeneMapper™ ID Software und 
dem Mentype® DIPplex Template File durchgeführt. 
 

DNA Längenstandard 550 (BTO) 
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Tabelle 4. Fragmentlängen der Allelleiter Mentype® DIPplex gemessen  
am ABI PRISM® 310/3130 Genetic Analyzer (blauer und grüner Panel) 

 
Marker/Blue -DIP [bp]* +DIP [bp]* Marker/Green -DIP [bp]* +DIP [bp]* 

AM 77 (X) 80 (Y) HLD118 77 81 

HLD77 84 88 HLD92 87 90 

HLD45 92 96 HLD93 98 103 

HLD131 100 113 HLD99 108 113 

HLD70 104 108 HLD88 118 128 

HLD6 118 133 HLD101 131 135 

HLD111 122 126 HLD67 140 147 

HLD58 136 140    

HLD56 144 149    

      

   
Tabelle 5. Fragmentlängen der Allelleiter Mentype® DIPplex gemessen  
am ABI PRISM® 310/3130 Genetic Analyzer (gelber und roter Panel) 
 
Marker/Yellow -DIP [bp]* +DIP [bp]* Marker/Red -DIP [bp]* +DIP [bp]* 

HLD83 75 79 HLD136 79 84 

HLD114 83 100 HLD133 91 102 

HLD48 89 94 HLD97 96 110 

HLD124 104 109 HLD40 106 129 

HLD122 115 126 HLD128 113 121 

HLD125 129 135 HLD39 125 143 

HLD64 138 144 HLD84 135 140 

HLD81 147 158    

      

  * gerundet auf ganze Zahlen 
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7. Interpretation der Ergebnisse 

Durch die vorher beschriebene Auswertung mit automatischer Allelzuordnung 
wird eine genaue und zuverlässige Unterscheidung der Allele gewährleistet. 
 
Überstrahlungen (Pull-up Peaks) 

Es kann zu Überstrahlungen zwischen den Farbpanels kommen, wenn eine 
ungeeignete Matrix für die Analyse verwendet wurde oder die Peakhöhen 
außerhalb des linearen Detektionsbereiches, z.B. größer 3000 relative 
Fluoreszenzeinheiten (RFU) liegen. Diese erscheinen an der gleichen Position wie 
spezifische Peaks in anderen Farbpanels (in der Regel mit niedrigeren 
Signalintensitäten). Um Überstrahlungen zwischen den Farbpanels zu vermeiden, 
sollten die Peakhöhen daher 3000 RFU nicht wesentlich überschreiten.  
 
Stotterbanden (Stutter Peaks) 

Bei STR-Motiven hängt das Auftreten von Stotterbanden von der Sequenz und 
Anzahl der Wiederholungseinheiten ab. Im Vergleich dazu entstehen bei DIP 
Motiven keine Stutterbanden. Die Peak-Zuordnung von DNA-Mischungen wird 
wesentlich erleichtert. Zur Bewertung der Peaks gelten die Vorgaben der 
Template Files für die Genotyper® und GeneMapper™ ID Software. 
 
Template-unabhängige Anheftung von Nukleotiden 

Die Taq DNA Polymerase hängt aufgrund ihrer terminalen Transferase-Aktivität 
bevorzugt ein Adenosin an das 3’-Ende des amplifizierten DNA-Fragments an. 
Wenn dem PCR-System nicht genügend Zeit für die Extension zur Verfügung 
steht oder wenn die Primersequenzen die Extension nicht begünstigen, findet 
diese Anheftung nicht statt. Dieses Artefakt ist durch das Auftreten eines um eine 
Base verkürzten Fragments (-1 Peak) erkennbar. Alle Biotype® Primer sind so 
gestaltet, dass diese Artefaktbildung minimiert wird. Zusätzlich wird die Bildung 
des Artefakts durch den abschließenden Extensionsschritt im PCR-Protokoll 
(68°C für 60 min) reduziert. Die Peakhöhe des Artefakts nimmt bei hohen DNA-
Mengen zu. Zur Bewertung der Peaks sollte jedes Analyselabor hierfür eigene 
Grenzwerte festlegen. 
 
Artefakte  

Die Raumtemperatur kann das Laufverhalten der PCR-Produkte an 
Kapillargeräten stark beeinflussen und bei zu geringer Temperatur zum Auftreten 
von Schultern oder Doppelpeaks (Split Peaks) führen. Aufgrund ihrer Sequenz 
reagieren insbesondere die Loci HLD77, HLD118, HLD92, HLD114, HLD136 und 
HLD40 verstärkt auf zu niedrige Umgebungstemperaturen während der Analyse. 
Sollten diese Effekte beobachten werden, empfehlen wir eine erneute Injektion 
der Proben. 

Außerhalb des Allelbereichs (>170 bp) können vereinzelt Amplifikationsartefakte 
mit sehr geringen Signalhöhen auftreten. 
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